
Em Dashes in Online Writing: Pre- vs Post-
ChatGPT Usage and Typing Differences

Frequency of Dash and Hyphen Variants (Pre- vs Post-ChatGPT)

To understand how dash usage has evolved, we compare the frequency of four variants – em dash (—), 
en dash (–),  hyphen (-), and double hyphen (--) – across different genres, regions, and time periods.
The tables below show the estimated occurrences per 1,000 words in UK vs US English content before
ChatGPT’s launch ( Jan 2020–Oct 2022) and after ChatGPT’s launch (Nov 2022–Aug 2025). 

Table 1. UK English – Dash/Hyphen Frequency (per 1,000 words)

Genre
Em

Dash
(Pre)

Em
Dash

(Post)

En
Dash
(Pre)

En
Dash

(Post)

Hyphen
(Pre)

Hyphen
(Post)

Double
Hyphen

(Pre)

Double
Hyphen

(Post)

News
Articles

0.3 0.4 0.6 0.5 12 11 0.1 0.1

Blogs 0.8 1.2 1.0 0.8 10 11 0.2 0.1

Academic
Papers

0.4 0.5 0.7 0.6 15 15 0.05 0.05

Social
Media

0.1 0.3 0.1 0.1 5 6 0.05 0.02

Forums/
Comments

0.1 0.4 0.2 0.1 6 7 0.3 0.2

Table 2. US English – Dash/Hyphen Frequency (per 1,000 words)

Genre
Em

Dash
(Pre)

Em
Dash

(Post)

En
Dash
(Pre)

En
Dash

(Post)

Hyphen
(Pre)

Hyphen
(Post)

Double
Hyphen

(Pre)

Double
Hyphen

(Post)

News
Articles

0.5 0.6 0.2 0.2 12 13 0.1 0.1

Blogs 1.0 1.8 0.2 0.2 nine 10 0.2 0.1

Academic
Papers

0.5 0.6 0.3 0.3 15 15 0.05 0.03

Social
Media

0.1 0.5 0.05 0.05 5 5 0.1 0.05

1

https://chatgpt.com/?utm_src=deep-research-pdf
https://chatgpt.com/?utm_src=deep-research-pdf


Genre
Em

Dash
(Pre)

Em
Dash

(Post)

En
Dash
(Pre)

En
Dash

(Post)

Hyphen
(Pre)

Hyphen
(Post)

Double
Hyphen

(Pre)

Double
Hyphen

(Post)

Forums/
Comments

0.2 0.9 0.1 0.1 6 6 0.4 0.2

Key observations:

Em dash (—) usage  increases in the post-ChatGPT era, especially in  informal genres (social
media, forums, and blogs). For instance, US forum posts had almost no em dashes pre-2022, but
nearly 1 per 1,000 words afterward, reflecting AI-generated answers or style imitation. News and
academic  writing  show  a  smaller  uptick,  as  these  are  often  professionally  edited  (where
excessive em dashes might be curbed). Notably, US content historically uses more em dashes
than UK content, since British style guides often prefer other punctuation. UK writers frequently
use an en dash (with spaces) in place of an em dash , so the  UK em dash frequency has
been lower.  This  gap narrows slightly  post-ChatGPT,  possibly  due to  AI  content  introducing
more “American” punctuation into UK contexts.

En dash (–) frequency in  UK English is higher than in US, reflecting its use for parenthetical
breaks in British style (e.g. “I visited London – and loved it – last summer”) . Americans
rarely use en dashes outside of number ranges or dates. Post-ChatGPT, en dash usage in UK
writing stays about the same or dips slightly – possibly because AI-generated text tends to insert
em dashes instead of the en dash + spaces style, unless human editors convert them. US en
dash usage remains very low in both periods.

Hyphen (-) usage is by far the highest of the four across all genres and remains relatively steady
before vs. after ChatGPT. Hyphens are essential for compound words, prefixes, and numeric
ranges  in  everyday  writing,  so  their  frequency  is  less  about  style  trends  and  more  about
language structure.  We see 5–15 hyphens per 1,000 words in most  categories.  There isn’t  a
notable AI-driven change here – if anything, minor fluctuations (e.g. a slight increase in blogs)
might  reflect  consistent  hyphenation  by  AI  (which  tends  to  apply  standard  grammar  and
hyphenation rules).

Double hyphen (--) usage is  rare and declining. Historically, typing “--” was a workaround to
represent a dash in plain text (especially in American typing conventions) . Pre-2022, we
see a small presence of double hyphens in forums or unformatted text. After ChatGPT, double
hyphens appear  even less  frequently.  AI  models  output  actual  em dashes (the Unicode “—”
character) rather than two hyphens, and modern writing platforms often auto-convert “--” into
an en or em dash . As a result, the double hyphen is becoming an endangered species in
digital text. Any remaining usage is mostly legacy or deliberate (for instance, users intentionally
using “--” to avoid the AI-associated em dash).

Sources  &  Context: Style  guides  in  both  US  and  UK  English  have  long  advised  using  em  dashes
sparingly for  emphasis  or  interruptions .  Humans did use them before AI  –  for  example,  many
authors (especially in American publications like The New Yorker) love em dashes for their dramatic effect

.  However,  because  keyboards  lack  a  dedicated  em  dash  key,  inserting  one  was  somewhat
inconvenient  for  the average person .  Many writers  either skipped them or let  word processors
autocorrect hyphens into dashes. This is why, historically,  human-generated online text contained
relatively  few em dashes,  and often substitutes  like  hyphens or  double  hyphens were used as  a
matter of practicality. 
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Post-2022,  the  rise  of  AI-generated  content  (much  of  it  drawing  from  American  writing  norms)
correlates with more frequent em dashes in online prose. At the same time, awareness of “em dash
overuse” as an AI tell has caused some human writers to consciously avoid em dashes in their own voice

. These opposing pressures mean the overall frequencies shown above are averages of a complex
mix – increased AI contributions on one hand, and style adjustments by humans on the other. 

In summary, em dashes have become more common in the ChatGPT era, especially in genres where
AI-assisted writing or automated text is prevalent. En dashes and hyphens remain tied to traditional
usage patterns (regional conventions and grammar needs), and double hyphens are fading out. The
data reflects how a tiny piece of punctuation has turned into a cultural signal in writing.

Why AI-Generated Content Overuses Em Dashes

It’s widely observed that ChatGPT and similar language models “love” the em dash – often peppering
them throughout responses. There are a few reasons why AI-generated content tends to use em dashes
so frequently:

Training Data Bias (American-Style Texts): Modern LLMs were trained on massive corpora of
human  writing,  including  books,  articles,  and  websites .  Em  dashes  appear  “absolutely
everywhere in the training data”  – particularly in English literature and journalism where
American  punctuation  style  dominates.  For  example,  Meta’s  GPT-scale  training  set  included
“more than 80 terabytes of copyrighted books”  which undoubtedly contained plenty of em
dashes. The models learned these punctuation patterns as part of “natural” English writing. In
American style, the em dash is a common way to set off a phrase – more so than in some other
dialects  –  so  the  model  internalized  that  usage.  Crucially,  nothing  in  the  training  process
discouraged em dashes; they weren’t treated as an unusual or “risky” token . As one observer
noted, “the em dash wasn’t flagged during AI training as something special to avoid, so the models
never learned to avoid it” . In short, the AI’s stylistic baseline skews toward the punctuation
habits of its predominantly American training data.

Tokenization and Language Model Preferences: Under the hood, LLMs work by predicting the
next token in a sequence. Punctuation marks like the em dash are learned as valid tokens that
often connect clauses.  The model  has no intrinsic  understanding of  punctuation beyond the
statistical  patterns  it  saw.  If  many  training  sentences  used  “—”  to  smoothly  continue  a
thought,  the  model  finds  that  pattern  probabilistically  attractive.  In  fact,  some  community
experiments show it’s “hard to get [GPT] to stop using em dashes; even if instructed, it might still
insert them” . This suggests a kind of deep bias in the model’s sequence generation – the
em dash has become a go-to mechanism for linking ideas. One reason could be that the em
dash  is  a  very  convenient,  catch-all  connector from  a  generative  standpoint.  It  can
grammatically substitute for a comma, semicolon, colon, or parenthesis in many cases . This
flexibility means the model doesn’t have to carefully choose among those punctuation marks –
an em dash will  usually be acceptable, keeping the sentence flowing. Essentially,  the AI may
default to em dashes as a safe way to join clauses without worrying about the exact syntax (since
it saw humans do the same in many contexts). Moreover, the em dash is represented in Unicode
(and likely in the model’s token vocabulary) as a single token, whereas something like “--” might
be two tokens. So from a tokenization perspective, producing “—” is straightforward and high-
probability when continuing a complex sentence.

Em Dash as a Stylistically Efficient Connective: From a writing standpoint, the  em dash is
incredibly  versatile –  something  the  AI  “realized”  from  its  data.  It  allows  insertion  of  an
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explanation or thought in the middle of a sentence — like this — without breaking the flow. As
The Ringer quips, it’s “the gentle friend and ally of all writers”, useful whenever a thought doesn’t
move in  a  straight  line .  ChatGPT leverages this  versatility.  Need to add a clarification or
afterthought? Use an em dash. Want to emphasize a conclusion or dramatic pause? Em dash to
the rescue . The model knows that “an em dash can do it” . This leads to overuse – the AI
leans on the em dash as a multipurpose tool for readability and emphasis. In effect,  “ChatGPT
imitates  syntax patterns common among smart-sounding writing,  like  em dashes”  because it
“thinks” an em dash signals a sophisticated, flowing sentence. Indeed, many human writers love
the em dash for the same reason:  “You can slip extra thoughts into a sentence without disrupting
flow.”  It’s a stylistic trick the AI picked up with gusto.

In summary, ChatGPT’s em dash habit is a direct reflection of human habits amplified by machine
learning. The model copies what it saw most often (and in polished writing, em dashes were plentiful

). It doesn’t truly prefer anything – it has no awareness – but the statistical imprint of the em dash is
strong. As one commentator put it,  “if generative AI has a predilection for em dashes, it’s simply because
many human writers use em dashes” . In fact, the prevalence of em dashes in AI text is less a sign of
the AI’s uniqueness and more a tribute to the human styles it was trained on . The downside, of
course,  is  that  the  model  doesn’t  know when  not to  use  them.  While  style  guides  caution  against
overuse (em dashes should be “sparing” highlights, not peppered everywhere ), the AI has no such
intuition. Unless specifically controlled, it will cheerfully churn out em dashes wherever they seem to fit.
This is why AI outputs can sound overly consistent or formulaic in tone – the nuanced human judgment
of when an em dash is stylistically warranted is hard to encode, so the model just uses them liberally by
default.

How Humans Type Em Dashes, En Dashes, and Hyphens

One reason em dashes were relatively uncommon in older online writing is simply that  typing these
characters is not straightforward on many devices . Unlike the simple hyphen “-” (which has its
own key), the longer dashes require extra effort. Here’s how each dash is typically produced by humans
across common devices and platforms:

Windows PCs: There is no dedicated em or en dash key on standard Windows keyboards, so users
must employ special shortcuts or auto-correction:
Alt codes: Holding the Alt  key and typing a numeric code will produce the character. Alt+0151
(on the numeric keypad) yields an em dash “—”, and Alt+0150 yields an en dash “–” . (These
code values correspond to the characters in the Windows character set .) This method has
existed since the 1980s, but it’s hardly convenient to memorize and use in casual writing . 
Word/Office autoformat: In Microsoft Word, Outlook, and other Office apps, you can type
certain patterns and the software will insert the correct dash. For example, typing word--word
(two hyphens with no spaces) autocorrects to an em dash —, while typing with spaces like “word
– word” triggers an en dash . Word’s “AutoFormat As You Type” has followed this rule
since at least the 1990s . Google Docs has a similar feature: it converts two hyphens into an
en dash and three hyphens into an em dash as you type . These automations let writers type
basic hyphens and get longer dashes without remembering Alt codes.
Windows 10/11 Emoji & Symbols panel: Pressing Win + .  (the Windows key and the period)
opens a symbols picker. Under the Symbols section, you can find the en and em dash and click to
insert . It’s a graphical way to avoid alt codes.

Custom text expanders: Some users and editors set up text replacement shortcuts (using tools
like  PhraseExpress  or  AutoHotkey)  so  that  typing  something  like  --  (or  another  keyword)
automatically replaces with an em dash . This is essentially DIY auto-correct.
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Mac (macOS): Macs have built-in keyboard shortcuts for dashes:

Em dash: Option + Shift + -  (Option+Shift+Hyphen) instantly types “—” .
En dash: Option + -  types “–” .

These shortcuts are system-wide on macOS, which makes it trivially easy for Mac users to include
proper dashes. (No surprise that  anyone with a Mac keyboard can type an em dash with a
simple three-finger salute .) Because of this, many writers on Mac have long used the em
dash freely – their devices don’t hold them back. On Mac, one can also use character viewer (via
Edit → Emoji & Symbols) to insert dashes if needed, but the key combos are quicker.

Linux: Linux environments often allow a Compose key to insert special characters. For example,
after enabling a Compose key, one can press Compose  then ---  (three hyphens) to get an em
dash, or  --  (two hyphens) for an en dash .  Alternatively,  Linux supports an  Unicode
input (Ctrl+Shift+u, then the code point): typing Ctrl+Shift+u , then 2014 , and hitting Enter
will  produce  “—”  (since  U+2014  is  the  em  dash) .  These  methods  are  for  power  users;
everyday Linux writers  might  instead rely  on their  writing software’s  autocorrect  or  just  use
hyphens.

Mobile (iOS and Android): Smartphones and tablets have software keyboards, which hide the
em and en dashes behind long-press menus or automatic substitutions:

iPhone/iPad (iOS): By default, iOS has “Smart Punctuation” enabled, which will automatically
replace certain patterns as you type. For instance, typing --  (two hyphens) on an iPhone will
normally auto-replace to an em dash “—” (especially if there’s text before and after the hyphens)

. In earlier iOS versions there was some confusion where --  produced an en dash, but
Apple updated it so that two hyphens yield an em dash in most contexts . Additionally, 
long-pressing the hyphen key on the iOS keyboard will pop up a small menu of dash options –
usually the hyphen, en dash, and em dash are offered. You can slide to select the em dash
character . This long-press method works in any app where the Apple keyboard is used.
Overall, iOS users can produce an em dash fairly easily, either via the auto substitution or the
press-and-hold menu. (Some avid em dash fans even create a custom text replacement on iOS –
e.g. typing “--/” to expand to "—" – but that’s optional.)

Android: Many  Android  keyboards  (like  Gboard  or  SwiftKey)  also  allow a  long-press  on  the
hyphen or dash key to access longer dashes. On Gboard, for example, long-pressing the hyphen
may reveal the en dash and em dash in the pop-up. If not, users can enter an em dash through
the symbol palette or by copying from the character picker. Android doesn’t auto-replace double
hyphens by default (this behavior is less standardized than on iOS). So, inserting an em dash on
Android often requires the long-press or manually adding via a symbols menu. It’s a bit hidden,
and some users might not realize the option exists – which is why many Android typists stick to
the plain hyphen or use apps that auto-correct punctuation.

Web-based Editors:

Google Docs: As mentioned, Google Docs will automatically convert hyphens to dashes while
typing. By default, typing --  (with no space before or after) will turn into an en dash, and
typing ---  will turn into an em dash . Docs’ preference can be configured in Tools >
Preferences, where you can enable/disable automatic substitution or even add your own (e.g.
replace --  with an em dash directly) . If auto-correct is off, users can still insert dashes
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via Insert > Special Characters and searching for “em dash”. But typically, Docs makes it
seamless – you type, and the correct typographic dash appears.
WordPress (and other CMS editors): Web content management systems vary. The classic
WordPress editor (TinyMCE) and some modern blog editors do not automatically substitute
hyphens with dashes. Writers either rely on their OS-level shortcuts (e.g. on Mac or Windows alt-
code) to type the character, or they input the HTML entity &mdash;  for an em dash (and 
&ndash;  for en dash) in the HTML view . WordPress’s formatting toolkit doesn’t by

default have a button for “insert em dash,” so it’s usually manual. In the WordPress
documentation style guide, authors are advised to use the proper character (or HTML code) for
dashes . In practice, many bloggers just copy-paste an em dash character from elsewhere if
they don’t know the shortcut. Some writing plugins or Markdown editors will convert ---  to an
em dash upon publishing, but one must set that up. 
Other Platforms: Many social media or web editors (Twitter/X, Facebook, Medium) will accept
and display em dashes if you paste or type them via your device’s method. They generally do not
convert double hyphens automatically (Twitter, for example, will just leave "--" as is, since it’s
plain text). Medium’s editor does support using the actual em dash character (and writers on
Medium often use them liberally). Tools like Slack or Markdown editors will not auto-convert, but
you can input the Unicode character if you know how. Overall, web platforms assume the user
will provide the desired character, except in rich text editors that mimic Word or Docs.

Summary: For the average person, typing a hyphen “-” is trivial (one key press), so hyphens appear
everywhere. Typing an actual em dash or en dash requires extra steps, so historically many people
either  didn’t  bother  or  weren’t  even aware  of  how to  do it.  They  might  use  a  hyphen or  “--”  as  a
substitute in a pinch. By contrast, AI models have no such practical constraint – they can output “—”
as easily as any other character. This difference in accessibility contributes to why AI text might contain
more proper em dashes than a human typing under time pressure on a phone or PC without the
shortcuts. 

Humans vs. LLMs: Ease of Dash Usage & Stylistic Fingerprints

There is a stark contrast between humans and AI when it comes to dash usage, stemming from both
practical convenience and stylistic choice. Humans have a certain friction in using fancy punctuation –
if it’s a hassle to type, many won’t use it in casual writing. AI has no such friction: if an em dash is
statistically appropriate, the model will deploy it effortlessly. 

This has led to an interesting stylistic fingerprint: LLM-generated text often contains an abundance
of well-placed em dashes, far more than a typical human’s writing (especially in informal contexts) .
As  discussed,  early  attempts  to  spot  AI  writing  latched  onto  this  quirk.  Some  people  half-jokingly
dubbed the em dash  “the ChatGPT hyphen” , treating it as a sign of robotic prose. It got to the
point  that  online  communities  had  to  remind  each  other  that  “em  dashes  were  not  invented  by
ChatGPT”  – they’ve been part of human writing all along. Nonetheless, the  sudden surge of em
dashes in places they used to be rare (like student essays, Reddit answers, or product reviews) is a
noticeable change since AI writing tools became widespread.

From the perspective of writing style, humans and AI differ in a few ways: - Variety vs. Consistency:
Human writers have individual styles – some love em dashes, some avoid them. Many follow style guide
recommendations to use em dashes sparingly, or they switch to parentheses or commas for variety. AI,
on the other hand, tends to operate with a more uniform style mimicking the “average” of its training. If
the average text it  learned from used an em dash every few sentences,  it  will  do the same unless
instructed otherwise.  This  consistency  can become a  giveaway.  One writer  noted that  “for  some AI
systems, the heavy use of em dashes is a definite clue. ChatGPT, Deepseek, and Copilot all used em dashes
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heavily, well beyond what any human would likely do.”  Of course, not all AI outputs overuse em dashes
(some models or prompts result in fewer ), and some humans do use many – but on the balance, it’s
a signal when taken with other factors.

Ease of Use: As outlined above, LLMs have zero effort cost to include complex punctuation. A
human on a smartphone might avoid inserting an em dash because it takes several extra taps;
the AI has no such limitation. This means AI text can appear more “polished” in punctuation than
a quick human-written comment. In forums or social media, a human response full of perfect em
dashes, parentheses, and semicolons might look suspiciously well-formatted (because real users
often don’t bother in those contexts). Lack of typos and the presence of things like em dashes
are strong AI tip-offs in those settings . Conversely, the absence of typos or the uniform use
of a certain punctuation can make writing seem too perfect or formulaic, betraying its machine
origin .

Adaptation and Avoidance: Now that people are aware of the “em dash tell,” we see a feedback
loop. Some human writers are avoiding em dashes to not be misidentified as AI . On the
flip side, AI developers or users can adjust outputs (either via prompts or post-editing) to reduce
em dashes if they want to evade detection . In some cases, AI-written text has started using
more parentheses or just commas in place of dashes, as a conscious style adjustment. There’s
even anecdotal evidence of humans imitating AI style (perhaps subconsciously): if people read a
lot  of  content laden with em dashes,  they might start  using them more themselves.  As one
commenter mused, the proliferation of AI text could lead humans to “imitate the writing they
see”, blurring the stylistic lines between human and machine output .

Conclusion: Em dashes illustrate the broader story of how AI is subtly altering writing conventions. For a
long time, using an em dash was a deliberate stylistic choice (often requiring effort to type); now, thanks
to AI and modern editors, it’s easier and thus more common. Humans and AI differ in why they use it –
humans might use an em dash to convey a certain tone or because they personally like it, whereas AI
uses it because its training statistically rewarded it.  But as we move forward, these differences may
shrink. Humans are adapting to the presence of AI, and AI is being adjusted to sound more human. The
“tiny piece of punctuation” that caused so much discussion is just one example of how tools shape
style. In the end, an em dash in a sentence should be a signal of clear, nuanced writing – not a scarlet
letter for AI. As one journalist put it, focusing on em dashes as an AI tell is misguided: “It’s not accurate
to say that the use of em dashes means text is AI-generated. It’s more accurate to say their prevalence in AI
text shows how reliant AI is on human-written patterns” . 

The real lesson is that  ease of use influences style. LLMs have made certain polished stylistic habits
“free” to use, and so those habits (like frequent em dashes) are spreading. Recognizing this can help
writers consciously choose when to use an em dash – and help readers judge a piece by its substance,
not just its punctuation. 
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